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I 
remain amazed how the world of £100 pair 
photographic digital imaging constantly Indeed sometimes high
presents ever-widening horizons, new end cameras are simply 

opportunities for expression and methods of set to either Auto or P 
working. For those of us - and it's my guess that mode and left there! 
we still form the majority within the RPS as a The same applies to an 
whole and the Digital Imaging Group in image management 
particular - who learned our craft either in the program such as 
darkroom or by taking colour slides, DI provides Photoshop: many users 
new methods improving the way we used to don 't venture beyond 

Clive Haynes FRPS 
Chairman 

work whilst offering new opportunities that were the basics and explore even the most 
previously impossible. fundamental of helpful features, such as the 
It would be a full -time task to try to keep abreast non-destructive attributes of Adjustment Layers. 
of new developments in camera design and In view of some of these needs amongst our 
features, plus understanding ever-advancing fraternity we hope to provide, from time to time, 
programs - Photoshop CS4 is already with us. In features in DIGIT that will address some of 
view of this , perhaps we should take time to these topics. 
pause to consider carefully where we are going The flip-side of this particular coin is the need to 
- both as technically competent craft-based emphasise the value of pre-visualisation - that 
photographers and as imaginative artists with is to say, having a clear image in your mind of 
vision. There 's very little doubt that the the picture you want to make before you start. 
equipment currently available will meet our The days of film-based photography taught us to 
needs whether as enthusiasts or professionals. conserve our resources and to plan the shots. 
Indeed top-end equipment will satisfy the needs The same logic should apply to digital shooting 
of the most stringent and demanding but, as we all know, camera-based memory is so 
professionals. It's also true that we will continue relatively cheap that we frequently watch 
to push technical and artistic boundaries and colleagues taking multiple shots, hoping for that 
I'm certainly not questioning these single lucky strike. 
advancements. What I would like to draw We certainly live in a brave new world of digital 
attention to is the value in exploring and technology and most of us are running hard 
understanding what we already have, before simply to take advantage of technical 
pursuing yet another new camera for the sake developments as they meet our needs. We hope 
of perhaps two or three million more pixels that the DI Group will continue to inform and 
definition, or software that does little more than help all members to enjoy and share their love 
expand the options of existing features. I'm of photography, whether they are grappling with 
reminded about this as a result of developing comprehending new technologies or striving for 
my way of working with infrared images - more perfection with digital media they already feel 
of which in this issue starting on page 9. I'm comfortable with. CW,;[!/ fia:YYU½' FRPS 
using a camera that's a few years old with a 
trifling six mega-pixel spec and yet I have no 
problem in producing high-quality A3 prints with 
my inkjet printer - a two-year old model. Much of 
what we do must be the product of well-founded 
craft-based skills and workflow. I know from 
both teaching the subject and from my own 
experience that the fundamentals gained from 
manual cameras and working in the darkroom 
provide a firm foundation. I'm certainly not 
advocating that everyone goes back to basics 
and that progress isn 't possible without manual 
camera and darkroom experience, it 's just that 
people tend to jump in at the deep-end after 
buying state of the art cameras and high-spec 
software then , whether darkroom-based or not, 
suddenly discover that success is not the resu lt 
of the fabled press of a button! Among fellow 
photographers a great need remains. 
Photographers need to be reminded about the 
most appropriate ways of using the new 
generation of cameras and the benefits of really 
understanding the software. Like many, I've 
frequently encountered a £1,000 camera in a 

lA'IBT DISTINCTIONS 
FOR DI GROUP MEMBERS 

We like to congratulate DI Group members 
who have recently gained distinctions but at 
the time of going to press none had been 
notified to DIGIT by the Society in this period. 
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Committee Report from Secretary Bob Pearson FRPS 
Meetings and teleconferences since Autumn report to December 2008 

• Finance Expenditure for the year to date was just 
about within the income of £11,400 from some 980 
members. DIG IT was costing £7,000 annually. The 
subscription increase shou ld ensure break even. 
Membership needed to be increased. Graham 
Whistler would update the publicity brochure which 
would be available at as many events as possible, 
including regional meetings. A Digital Meetings 
events diary was thought to be essential. The India 
trip would generate little income because of the sma ll 
take up by RPS members. 
There was concern about the Group's ongoing costs 
which needed to be examined, including the options 
of cost savings by fewer pages in DIGIT; fewer issues; 
and limiting the summer issue to exhibition images 
on ly, together with the DVD. The Editor wou ld prepare 
a background paper for the next meeting. 
• Website and Forum The DI Group must have a 
good website but, sadly, the interactive facilit ies of 
the old site could not be afforded. Neither the Society 
nor the Group had available money to fund a web 
template for SIGs. The Committee did not want to rely 
on a single person again . Maureen Albright hoped to 
have a corporate template runn ing for the DI site by 
the AGM. Maureen would also seek to resolve the the 
Folio and Forum password issues so that global 
protection of authorised members wou ld mean less 
need for repeated password entering. 
• Regional Group Affairs Currently there were nine 
DIGROs in post and two vacancies in Scotland and 
East Anglia . The Committee was grateful to Tony 
Poole for taking over the Western Region . Chris 
Haydon wou ld set up a regular conference ca ll to the 
DIG ROs. The Society had produced a note on the 
appointment of Regional Officers which would be 
adapted for DIGROs. An environment needed to be 
created in wh ich DIGROs interacted with the DI Group 
Committee. 
Chris Haydon had compi led a list of DIGRO meeting 
centres which would be sent to new members. A list 
of new members would similarly be sent to DIGROs 
and Chris Haydon wou ld encourage DIGROs to 
contact new members, welcoming them to the area 
with a list of events. 
DIGROs would be asked to send regularly their diary 
of events to John Long so the events could be 
included in Membership Matters and in DIGIT. 

DIGROs would be listed in the AGM papers, alongside 
the Committee. 
• Improved contact with members The Secretary 
would set up a Group Email List of members and 
DIGIT would carry a plea to members to keep the 
Group up-to-date with changes to email addresses. 
• Exhibition Gavin Hoey has agreed to be the guest 
speaker and a selector for the exhibition . 
After discussing issues of print qua lity, it was agreed 
to maintain the present format and selection 
arrangements. This year the selectors wou ld be 
encouraged to choose more adventurous work. Every 
entrant would have one print selected with those 
submitting particularly high quality work having the 
possibi lity of a second being selected . The new Group 
Email List would be used to ask members to vote on 
the Forum as to whether they would prefer a digital 
projected image or a print exhibition from 2010 
onwards. 
The Exhibition might also be staged in the Yorkshire 
and Thames va lley regions. 
The cost of producing the Exhibition DVD was agreed 
as satisfactory. This year Graham Whistler would film 
the selection process, with each selector explaining 
why they had chosen particular prints. The DVD would 
have an option for a shorter slide show with music 
background on ly. 
• DIGIT Some editoria l support had been 
forthcoming with one regular column by Dr David 
Cooke and invaluable help from Elizabeth Restall in 
proof reading. A successor to Jim Buckley as editor by 
2010, perhaps with a number of members helping in 
specific areas, would be sought, with information 
published in DIGIT. 
• The Real Thing Chris Haydon would liaise with 
the Society about the possibility of Steve Caplin 
talking on photomontage and the ethical issues using 
Photoshop as a veh icle. 
• Other Matters The Group would extend an 
invitation to those who might form a panorama group 
to join the Digital Group. 
The possibil ity of using The Cheltenham Film Studio 

for weekend or day workshops of about 30 members 
wou ld be explored . 
2010 would see the centenary of infrared 
photography. The Chai rman would liaise with the 
steering group being formed. 

Have we got your Number? Look out for the DI Group emall 
As you'll see in the committee report above, we want to keep you better informed, and seek your 
views. A new email distribution has been established and you should be receiving it soon. 
But ... 
Members move, change telephones or now prefer mobiles rather than landl ines, and above all 
swap email providers and so addresses at the drop of a hat. Have you remembered to tell the 
Society? Electronic communications are increasingly important and we want to be able to contact 
you - assuming that is, that you are content to be contacted electronically by the DI Group. Please 
let the Secretary, Bob Pearson FRPS, know of immediate changes by email at 
secretary@digit.rps.org. Please also update your address, telephone and email details with Simon 
Bibb at The Society by telephone on 01225 325743 or email at simon@rps.org. 
The first email should be with you soon so if you haven't received it by the end of January it may 
be that we haven't got you r email , or it's incorrect. The email will welcome you to the new service 
and explain how to get the best out of it. 
Please help us to help you by updating your details now. 
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Digital Imaging Group 

DIGITAL REGIONAL 
ORGANISERS 

Contact the organisers 
listed below for full details 

Central Southern 
Roger Norton LRPS 

www.csdigital.co.uk 
cs_dig@tiscali.co.uk 

~ast Anglia 
Vacant 

East Midlands 
Bob Rowe ARPS 

www.rpsdigital-em.org.uk 
bob. rowe 10@ntlworld.com 

Midlands 
Clive Haynes FRPS 

www.midig.org 
c/ive@crhfoto.co.uk 

North West 
Harry Bosworth 

harrybos@aol.com 

Scotland 
Vacant 

Southern 
Dr Barry Senior HonFRPS 

barry@littlepics.freesrve.co.uk 

South Wales 
Maureen Albright ARPS 

www.southwales-dig.rps.org 
maureen@maureenalbright com 

Wessex 
Maureen Albright ARPS 
WWW.dig{, e S S CJ "rps.org 

maureen@maureenalbright com 

Western 
Tony Poole ARPS 

tonyfpoole@bluoonder.co uk 

Yorkshire 
Robert Croft LRPS 
http:,t/}Q'kshire

dig1mysite.ora"*"oo.uiv 
robert@robertcroft.wanadoo.co.uk 
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THINK PHOTOGRAPHY 2008 
Held In the conference suite of the Natlonal Motor Cycle museum, 

Think Photography 08 was a Joint venture between Jessops and the Society. 
Graham Whlstler FRPS reports on the DI Group contribution. 

Our Digital Imaging Group stand at t he weekend 
of 15-16 November 2008 held at The Nationa l 
Motorcycle Museum, Birmingham was very well 
supported. The Museum was a good venue for 
the show with adequate parking and easy 
access from the M42. 
We were part of a major RPS presence at the 
conference and trade show. Jessops joi nt ly 
sponsored the event with the RPS and set up 
well stocked t rade stands and seemed to be 
doing good business. We were downsta irs in the 
conference room with all t he Society stands and 
specia l interest groups positioned round the 
busy conference presentation area. 
Our stand had a backdrop with selected prints 
from this year's members' exh ibition . We also 
had a large monitor running t his year's 
exhibition DVD. Supplies of back issues of DIGIT 
were eagerly taken by the many photographers 
who came to our stand over the two busy days 
and I think we may we ll have gained some new 
members. 
The LRPS judging Pane l was also in open 
session during the weekend and it wa s 
fascinating to observe their care and rigorous 
standards at first hand . We were ab le to 
publicise the RPS DI Gro up India To ur in 
January, now nearly ful ly booked, so we shou ld 
have some great images for the spring DIGIT. 
Several of the trade stand representatives gave 

Left: Three wise Fellows: 
Noel Shaw, Philip 
Antrobus and Graham 
Whistler ready for the off. 

Right: Clive Haynes 
speaking during his well
received demonstration 
on digital JR 

Below: Philip Antrobus 
engages with potential 
young members 
Right: Vice-Chairman 
Chris Haydon mounts 
some of the Exhibition 
prints 

Right Elizabeth Restall, 
Group Treasurer, shows 
off DIGIT to a potential 
member. 

Right: DIGIT Editor Jim 
Buckley explains the 
Group's role. 

Left: Clive Haynes and 
Dorrette McAuslan enjoy 
a moment's relaxation 
during a non-stop busy 
weekend. 

ta lks and demonstrations on photography and 
their new products. Nikon and Canon presented 
some of their latest equipment with Fotospeed 
and Permajet ta lking about their range of art 
papers. Mike Lane FRPS and Bob Moore Hon 
FRPS and DI Group Chairman Clive Haynes 
FRP_S gave presentations to fu ll houses with late 
comers having to stand. Cl ive made a very 
informative and well presented ta lk on Digital IR 
using a specia lly converted Nikon D70, and you 
can read more about that starting on page 9. He 
projected severa l dramatic and creative 
examples with easy to fol low gu idance on how to 
achieve those results. 
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Chairman, Clive Haynes FRPS adds: 
Thank you to the 

volunteers 

Clive Haynes FRPS 
Dorrette McAuslan LRPS 
Elizabeth Resta/1 LRPS 
Chris Haydon 

The many interesting trade stands were all busy 
with Sony showing it's all new full frame digital 
SLR A900 with 24.6 MP CMOS sensor. The 
camera looks good and at under £2000 for 
body only it will keep Nikon and Canon on their 
toes. Sony as yet have only a limited range of 
high quality lenses made for them by Zeiss for 
the new camera; the older Minolta/ Sony range 
are unlikely to reso lve all the high detail from 
the 24.6 MP chip. 
Nikon kept their cards tight to the chest at the 
show about their new Nikon D3X with full frame 
24.5 MP CMOS all new chip producing 50mb 
RAW files. Officially released to the world on 
Monday 1 December 2008 at a projected price 
of £5500 for body only, they are aiming for a 
different market. 

This busy event went very well for us and all the 
planning proved to be most worthwhile. 
Everyone who volunteered to help made it and 
they have my grateful thanks. In particular, 
Graham gave fabulous support and generously 
provided his personal equipment which made 
our stand lively with the Exhibition DVD running 
on a very large monitor throughout the 
weekend . 
The consensus was that around 800 to 1,000 
people attended. The Society area and trade 
stands were kept busy and lectures were all 
presented to large audiences. Other Special 
Interest Groups represented seemed to be 
having good levels of interest and, when I was 
on our stand, I found lots of interested visitors. I 
was also able to help with some advice and 
guidance to those considering a submission for 
a distinction. 

Philip Antrobus FRPS 
Noel Shaw FRPS 
Graham Whistler FRPS 
Jim Buckley LRPS 

Are these new digital cameras resolving more 
detail than perhaps we can see, or need, for 
most applications? 

DIGIT NEEDS YOU! 
Do you fancy the Editor's chair? Or perhaps helplng source artlcles and Images? 
Do you enJoy desktop publlshlng and layout? Or checking and proofing other 
photographers' artlcles? Are you persuasive with busy people to convince them 
to contribute? Please contact the Editor, Chairman or any committee member to 
discuss this If you'd llke to help. 
At the end of this year, my fifth as editor, I estimate that I will have put together over 700 pages of DIGIT, along with brochures 
and flyers for special events. Picking up the baton from the pioneering members who established the DI Group, DIGIT has 
grown from my first 20 pages of black and white to a regular 32 page, and occasionally more, full colour magazine. It is now 
in its 40th issue and has an established look and regular format. I print with Ian Allan who also produce the Journal. 
By 2010 it wi ll be time to hand over to someone with new direction and fresh ideas. At the same time the economics of DIGIT 
need careful attention since it consumes the bulk of our annual income - that is, your subscriptions. 
So what's involved? Let's break it down into its component parts - in order of production not priority since these roles can be 
allocated to several people working with the editor: 
• Generating ideas for artic les and images and persuading members to write them; 
• Watching the Folio for outstanding digital images and persuading the photographers to explain how they created them; 
• Getting the expert teachers to produce How To pieces; 
• Checking that the articles are sound and the tutoria ls are clear and really do what it says on the tin; 
• Laying out text and images, within a defined grid, to be attractive and clear; 
• Liaising with the printer on schedules and special inserts such as the Exhibition DVD; 
• Liaising with the Society for the membership mailing list, sorting in a spreadsheet for cheapest postal prices. 

Articles and Images for Spring 2009: Copy Date end February 
DIGIT re lies on t he contributi ons of members. So, when wi ll you send me an artic le for DIGIT? Remember that 
everyone is learning and that al l experience is va luable. We look forward to hearing from you . Thank you . 

Jtw. "B.ucR.LetJ LR.PS ~olttor Email: editor@digit.rps.org 
1 Aldenholme, Weybridge, Surrey KT13 0JF, UK 

RPS DI Group Yorkshire Region Meetings and Print Exhibition 
1000 Sunday 18 January 2009 . 

Print Lecture: One Step Beyond Ricky O'Neil FRPS Contact Robert Croft. Regional 
1000 Sunday 29 March 2009 Organiser:: Tel: 01977 

685262/ Lecture/Demonstration Creatively Digital 
Gwen and Phillip Charnock FRPS. 

Ticket events only 
£5 to RPS DI members/ £6 otherwise 
Cheques to RPS Yorkshire DI Group. 

RPS DIGIT Magazine Winter 2008 

07876 655801 
Emai l: 

WebSite: www.ydig.co.uk 
Robert@robertcroft.wanadoo.co.uk 

Saturday 25 April and Sunday 26 April 
Yorkshire D I Two Day Print Exhibition 2009 

To be shown at 
North Light Gallery 

Brooke's Mill, Armitage Bridge 
Huddersfield, HD4 7NR. 

Free Admission and Car Parking 
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BOB PEARSON FRPS 

GmlNG THE BALANCE RIGHT 
Bob Pearson, Secretary of the DI Group, outllnes his approach to the tricky area of White Balance, 
explalnlng how to ensure your Images have as near as posslble a falthful rendering of the origlnal 
colours of the scene by carrying a relatlvely Inexpensive tool In your camera bag. 

0 ne of the characteristics of light is its 
colour temperature. One of the unfamiliar 
controls that a photographer finds when 

changing from a film to a digital camera is that 
ca lled White Balance , perhaps better 
understood as Colour Temperature Correction. 
Daylight Films were balanced so that a white 
object was rendered white when the colour 
temperature of the incident light (the light 
falling on the subject) was about 5500 degrees 
Kelvin; Tungsten Film was balanced for an 
incident light temperature of 3200 degrees 
Kelvin. Without colour correction filters on the 
lens daylight film would produce a bluish image 
on a cloudy day but enhance the warmth of a 
sunset. Unlike film, the sensor of a digital 
camera has no inherent colour balance: this is 
determined by the processing of the data from 
the sensor. By default, a digital camera is set to 
Auto White Balance, that is the processing tries 
to render a white object as white, irrespective of 
the colour temperature of the incident light. 
Under such circumstance it can be 
disconcerting how sunsets lack the warmth that 
we had become used to when using Daylight 
Film. 
If the processing is done in the camera (that is, 
producing a jpeg file) then it is the camera 's 
white balance setting that determines the final 
colour balance of the image. 
Typical options for white balance presets are 
shown in the table alongside. The more 
sophisticated cameras offer many more 
settings under the general heading of 
fluorescent, covering all types from sodium 
vapour lights to high temperature mercury 
vapour lights. 
To replicate the result of a film camera leave the 
setting fixed at a value between 5200 - 5500 
degrees. To deliberately achieve a slightly 
warmer image set the colour temperature 
slightly higher than its normal setting, that is, 
set it to cloudy for direct sunlight conditions. 
If a digital negative is created by shooting in 
RAW mode then the colour temperature is not 
'baked in ' to the image until the point of 
development. There are many software 
programs available to execute this 
development, either specifically provided by the 
camera manufacturer or generic such as Adobe 
Camera Raw (ACR ). When choosing the 
parameters to be used for this conversion from 
the raw image it is certainly possible to use the 
co lour temperature that was set on the camera 

Option 

Auto (Default) 

Incandescent 

Fluorescent 

Direct Sunlight 

Flash 

Cloudy 

Shade 

Choose 

at the time of exposure: the 'as shot' setting. 
Much more importantly, at this point the white 
balance can be set to any value that the 
photographer chooses. On many images it is 
desirable to move away from the 'as shot' value 
to increase the aesthetic appeal of the image. 
The algorithm to determine the white balance of 
an image in the camera's Auto mode has 
become increasingly complex. In the early days 
the algorithm was little more than averaging the 
colours in the image and setting the colour 
balance to produce an average grey, a method 

Colour Temp 
Description 

(Degree Kelvin) 

3500-8000 Adjusted automatically 

3000 
For Incandescent/ 
Tungsten lighting 

4200 For cool white fluorescent 
lighting 

5200 
For subjects in full sun 

(1000-1600) 

5400 For flash lit subjects 

6000 Use under overcast skies 

8000 
Use in daylight when 

subject is in the shade 

2500-10000 
Choose colour temp 

(deg K) setting 

KELVIN? 
Irish-born William Thomson (1824 to 1907) was 
a brilliant mathematician and physicist. Professor 
of Natural Philosophy - physics - at Glasgow at 
just 22, his major contributions in physics 
included electricity, magnetism and 
thermodynamics. He was created Lord Kelvin for 
his work on the first transatlantic cable, having 
moved into the field of engineering. But it's his 
work in establishing a temperature scale - the 
Kelvin scale where zero (0 K) is absolute zero, the 
absence of all thermal energy - with which his 
name is now forever linked. The colour 
temperature scale is represented by the colour of 
a black body when at the given Kelvin 
temperature. A black body is a theoretical object 
which is a perfect absorber and emitter of 
electromagnetic radiation - light in our case. As 
the black body is heated it emits light which 
changes from red through yellow to blue 
according to its absolute (Kelvin) temperature. 

' 

' 

RPS DIGIT Magazine Winter 2008 



clearly prone to error where there was a very 
predominant colour in the image. As an 
example of current sophistication, in the latest 
Nikon cameras white balance is part of the 
scene recognition system and it is only possible 
to hint at the complexity of this system. Nikon 
has for some years used a separate dedicated 
1005 pixel RGB sensor to evaluate the scene 
from a store of tens of thousand of images. In 
order to improve the accuracy of this system a 
diffraction grating (which acts like a prism) has 
now been introduced. This splits the light so 
that mostly only the red light is incident on the 
red filter of the sensor, similarly for the green 
and blue light. The type of scene, the colour and 
brightness of the scene are extracted. This 
integrated system determines the colou r of the 
incident light very accurately. Nikon claim that 
the system can decide whether the light 
incident on a scene is from a mercury vapour 
lamp for example. When the system detects the 
scene is lit by tungsten lighting it will leave the 
scene slightly warm, as human eyes see the 
scene. 
Despite the accuracy of modern cameras there 
are occasions when a second reference is 
worthwhile - for nature and record photography 

Above and right 
Place the grey card in your scene and take an 
exposure. Remove the grey card and continue 
shooting under the same lighting. 
Open the image which you took with the grey card 
in your photo editing software - here we've used 
Ughtroom. Choose the White balance eye dropper 
and click on the grey card. The colour shift is 
marked and we now have a faithful rendering. 

RPS DIGIT Magazine Winter 2008 

Above: WhiBal on the 
left and ExpoDisc on the 
right. 
The WhiBal offers a 
range of tones from 
white, two greys and 
black. The multi-prisms 
of the Expodisc are 
shown clearly. 

for example where the colour of the subject can 
be particularly important. Amongst the most 
popular items for achieving a good white 
balance of a scene are the WhiBa/ and the 
Expodisc. The WhiBal is simply a portable, 
rugged , precision grey card. The Expodisc slips 
onto the front of the lens and has a series of 
prisms facing outward that remap the incident 
light into an even monotone that is the 
integration of the colour temperature of that 
light. 
Using either system does need some care. The 
Whibal is used by placing it within the scene 
being photographed, taking one shot and then 
removing it for subsequent images taken at the 
same location. Images are taken in RAW mode 
and the white balance for the series determined 
in the software by using the white balance 
picker in, for example, ACR and clicking on the 
WhiBa/ where it appears in the first image so 
that it is registered as a true neutral grey. The 
resultant colour temperature is then used for 
the rest of the series of images. An example of 
how to use the colour picker is shown below. 
It is essential to realise that the WhiBa/ reflects 
the light incident upon it: it must therefore be 
facing the camera at an angle as close to ninety 
degrees as possible. For example, It is all too 
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OBPFARSON 
easy to place the WhiBal carelessly on the 
ground such that it reflects much more blue 
light from the sky than that incident on the 
subject. An alternative to placing the grey card 
in the scene, for example when taking wildlife 
where it is inappropriate, is to handhold the 
WhiBal facing the camera. 
It is not without its pitfalls as demonstrated in 
the two pairs of images shown below. The first 
pair shows the image corrected using the 
WhiBal reading. Looking at the light grey 
plumage of the Stilt (the smaller bird on the 
right) the image is clearly too warm. Checking 
the light grey plumage in the 'as shot' image 
shows that the camera on auto was within 100 
degrees Kelvin of the value to make the 
plumage a neutral grey. What went wrong? 
Well, you will notice that my assistant holding 
the WhiBal was wearing a blue shirt and this 
was unfortunately reflecting onto the card . 
The Expodisc also has its limitations. It is 
sensible to buy a large diameter version to 
cover all your lens diameters and then use 
adapters down to each lens size. If the camera 
is on a tripod it's possible to handhold it over 

Below: Using the 
WhiBal in practice 

the front of the lens but it is rather awkward. 
There are clearly some lenses, very wide angle 
ones for example, which it simply won 't fit and 
so it is necessary to change the lens to get a 
reading. The Expodisc converts the camera to 
an incident light meter so the best way to use it 
is to compose the picture with the camera on a 
tripod , remove the camera, fit the Expodisc and 
walk to the main subject, point the camera 
back to the tripod and take a reading. Not 
always very practical! The reading is recorded 
into the manual preset white balance setting of 
the camera and used for subsequent images at 
this location. 
When judging how successful the colour 
correction of an image has been be aware of 
the following points. A scene lit with two 
different colour temperature sources can never 
be correctly balanced over the whole image. In 
addition , we generally assume, and usually 
work with , light sources that have a continuous 
spectrum. A low-pressure sodium light is 
monochromatic: images lit by such a source 
can only be monochrome and white balance is 
academic. 
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CLIVE HAYNES FRPS 

SHOOTING THE INVISIBLE 
In this second part of his major exploratlon of dlgltal Infrared, Chairman Cllve Haynes FRPS looks 
at Infrared capture and workflow In more detall, venturing Into artistic Interpretations. One of the 
fascinations of recording a scene In IR, says Cllve, Is that the world Is revealed with a different tonal 
response to that with which we're famlllar. In this respect no one can tell you that It's Incorrect. 
How you record and adjust the tones and manage so-called false colours Is entlrely your own affair 
and the product of your artistic Judgement and aesthetic senslblllty. At the end of the artlcle Cllve 
also hlghllghts some problem areas which you may meet In explorlng IR with a dlgltal camera. 

Eglise de Gabanac and 
Vines 

Choice of JR Filter Depth 

W
hen deciding to have a camera 
converted for IR take a moment to 
consider the depth of the filter you 

need. Unti l fairly recently the most common IR 
filters were for wavelengths of around 720nm. 
Many specialists can now offer as an 
alternative a deeper IR filter at around 830nm . 
Which one to choose? Deeper is not 
necessari ly better - it's simply different. If you 
prefer a deeper filter to see further into the 
infrared, it comes at a price. 
That price is an image that will be pretty well 
monochromatic, revealing little or no false
colour characteristics. Monochrome is what 
one expects from IR; however, at 720nm near
lR frequencies contribute to the attractive 
properties of Ch annel Swapping and 
associated manipu lat ions. So if you wish to 
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uti lise the pictorial effects and alternative 
colour tonalities of Channel Swapping or Lab 
Color Mode working (see later) then a 720nm 
fi lter wil l serve you better. 
White Balance 
In Part 1 I emphasised the importance of 
setting a custom white balance and the benefit 
of shooting with RAW files. JPEG files can be 
used but offer less f lexibil ity when we need to 
exploit the range of tones, some of which wil l 
frequently be off the scale both for JPEG and 
the in-camera histogram display. Setting a 
custom wh ite ba lance helps in presenting more 
meaningful information for the camera-based 
histogram. A custom white balance will typ ically 
provide a more evenly dist ributed channel-to
channel histogram for each of the three RGB 
channels and, thereby, a more favourable tonal 
range for initial adjustments in RAW and future 
image management. 
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CUVE HAYNES FRPS 
Bit Depth, Modes and Gamut 
For better image processing, fidelity and control, 
16 bit working is preferred. Set your RAW file 
reader to open as 16 bit and remain with 16 bit 
operation until you feel that further tonal and 
colour adjustment will not benefit from 
continued 16 bit working. At this point you may 
choose to swap to 8 bit working (Image > Mode 
> 8 bit). Also you may wish to save on file size 
and utilise features only available in 8 bit. There 
are some advantages to working in Lab mode 
(Image > Mode> Lab Color) these are worthy of 
exploration and we 'll look this option more 
closely shortly. But first a short note about 
gamut. 
Modifying and extending the image histogram, 
converting to other modes and applying unusual 
processes can sometimes result in a wider than 
expected colour gamut. It may therefore be 
preferable to alter the colour profile of the 
image to one which offers a greater colour 
space. Many photographers will already be 
using Adobe RGB (1998) as the default colour 
space as this is frequently preferred to the more 
modest sRGB space: however, for some images 
and procedures wider gamuts such as Pro 
Photo RGB may be preferable. 
To change the colour profile go to Edit > Convert 
to Profile and make your choice. 
Experimentation will be the key. Remember 
though that for output to currently available and 
affordable inkjet printers, the results of opting 
for wider gamuts may not be apparent in the 
final print. However, for good practice one 
should maintain maximum fidelity throughout 
the image workflow so far as is practicable, 
bearing in mind that other applications and 
high-end commercial printers can take 
advantage of wider gamuts and more 
accommodating colour spaces. 
Channel Swapping 
The method of Channel Swapping was 
described in the autumn edition of DIGIT and is 
reproduced in the grey box opposite. The highly 
manageable and subtle results obtained are 
usually my preferred method of working with IR 
images. 
Now for something different and wonderful -
Tonal Adventures with Lab Color. 
I use an IR converted Nikon D70, with in-camera 
Custom White Balance (important - see autumn 
DIGIT). I open RAW files in Adobe Bridge, then 
to Photoshop CS3. I've included screen-grabs 
which illustrate Histogram, Channels and 
Layers. However, there is no 'follow this route to 
success ' workflow for exploring the tonal 
opportunities in Lab. Hopefully, the following 
examples will point the way and provide an 
introduction. Please remember that the results 
will be image-dependent and the examples 
illustrated here may not be replicated with your 
chosen image. 

Tonal Adventures with Lab 
Lab Color Mode separates Lightness (L) from 
the two colour channels those of 
magenta/ green (a) and blue/yellow (b). The 
separation of L, a and b allows the colour 
channels to be adjusted independently of the 
Lightness channel. For example, you may wish 
to invert (make negative) Lightness only, or 
invert one or both colour channels. The effects 
can be weird and bizarre but for the right image, 
the results can be both striking and successful. 
The ability to separate the L, a and b channels 

can offer certain advantages and these allow 

Channel Swapping 

Maillezais Abbey 
IR capture with Lab 
adjustment 

Open the selected image and create a Channel Mixer adjutment layer. In 
the Channel Mixer dialogue box: with the Output Channel set RED, 
change the Red Source Channel to 0% and set the Blue Source Channel 
to100% 
Go to the BLUE Output Channel and change the Blue Source Channel to 
0% and set the Red Source Channel to 100%. Click OK 
At this stage the image may display a range of muted colours, depending 
upon the content of the scene. 
Next, create a Levels adjustment layer and click Auto Levels. (Yes, not 
something most of us would normally do I know but have faith; this 
provides a really useful boost in contrast.) Following Auto Levels, the 
result is frequently of a pleasing tonal range, however, it is, of course, 
image-dependent: for example in a scene including a blue sky and some 
clouds Channel Swapping will tend to give a result which offers a blue
shaded sky with the remaining areas represented by tones of peach, 
apricot, magenta and cool slate blues mapped over the grey-scale 
content. 
At this point you can decide to work with the partially toned result or 
convert to monochrome, apply Curves, colour tone, whatever. However 
for some images the following additional tweaks may prove of service. 
Try Image> Adjustments>Auto Colour and lmage>Adjust>Auto Contrast. 
The above are naturally content and contrast dependent but sometimes 
they give that little extra. And such factors do inject an element of 
serendipity into the process - just like the old days really! 
It's an advantage to make an Action for the Channel Swap and Auto
Levels procedure as this will probably become the most frequent quick
process route for pleasing results for many subjects. 
Should you wish to view the image without the Channel-Swap then 
simply switch off the Channel Mixer Adjustment Layer. 
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Note: Quick key/short-cuts 
shown in brackets are for PC. 

Above: The Skiff and The 
Hulk. Orie1jnal unprocessed 16 
bit RAW file and associated 
Histogram, 01annels and Layers 
palettes 

Channels palette 

Channel b active 

- l( 

Channels >< ~==== _ 
!!, Lab Ctr!+.., 

D· Orl+2 

- b Orl+3 

a :,J ~ 

numerous excursions and adventures. To 
indicate the variables that one can enjoy I'm 
going to use my image (left) of The Skiff and 
The Hulk as an example. Please remember that 
not all tonal changes will affect all images 
equally and that the results obtained are, 
understandably, referred to as false colour: 
therefore the tones and colours cannot be 
wrong - only more or less pleasing or 
appropriate. 
Open the starting image and convert to Lab 
Color (Image > Mode > Lab Color) - see screen 
grab left. 
Make sure that you can see the Channels 
palette, shown below left. If it's not visible go to 
Windows > Channels. 
Beginning to explore the flexibility of Lab mode, 
experiment by Inverting (making negative) each 
channel. This simple exercise will illustrate the 
independence of each channel or combined 
Channels. We have seven independent options 
at our disposal: L, a or b individually, and the 
combinations L/ a, L/ b, a/ b, L/ a/ b. To 
understand the principle we'll look at just two -
comparing b alone and the combination b/ L. 
Click/ highlight Channel b (quick-key= Ctrl+3) -
see left. Make certain that the eye icons for 
each of the Channels are on but only the b 
Channel is highlighted/ active. 
Go to Image > Adjustments > Invert (Ctrl + I) 
and the image (below) will be subtly different 
from our original shown at top left as only b 
(blue content) has been inverted. 

Undo the 
~ change above, 

Edit > Undo 
Invert (Ctrl + Z) 
to restore the 
image to the 
starting point. 
The next step in 

this introduction is to Invert more than one 
channel by choosing a Channel , say b, then 
shift-clicking on, for this example, the 
Lightness Channel. 
Two Channels will now be highlighted, as 
shown on the left. Once both Channel b and 
Lightness Channel are active, invert this 
combination (Ctrl + I) and here is the very 
different result, now incorporating the 
Lightness Channel. The effect will not be to 
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everyone's taste but you can begin to 
understand how valuable access to individual 
channels can be. If you wish to experiment with 
reduced intensities of Invert, go to Edit > Fade 
Invert and adjust the slider control. Also, as an 
option in this dialogue box, different Blend 
Modes can be tried. NB Edit > Fade is only 
available immediately after making the Invert 
command as shown below. 

File Image Layer Select Filter Analysis Vi 

Undo Invert 

·-;tep F1A \l<Jr d 

Step Backward 

Ctrl+Z 

,h1f1+• l+Z 
Alt+Ctrl+Z 

Fade Invert . .. Sh1ft+Ctrl+F 

,:..it 

Copy 
rop, •·lerged 

Ct,l+x 
Ctrl+C 

f,••+etrl+C 

For an alternative and more flexible approach 
we're going to explore the subtle (and 
sometimes not-so-subtle) use of Level changes 
to Channel a and Channel b. 
To follow this route return to the image starting 
point. Look at the Histogram: if not visible, go to 
Window> Histogram. This Window option is not 
available on pre CS versions of Photoshop, in 
which case observe the Histogram as we 
proceed via Levels. 
Activate Channel a. This reveals a sharp spike 
of Histogram information which represents the 
narrow range of tonal information captured in 
this channel. 
We seek to expand the tonal range by adjusting 
Levels. To do this go to Image > Adjustments > 
Levels. For the working example I adjusted the 
black, white and mid-level sliders to produce 
the result here. Adjusting Levels controls the 

amount and distribution of magenta/ green for 
Channel a. Adjusting Levels for Channel b will 
control the distribution of yellow/ blue - below. 

Whilst the Levels dialogue box is open , it 's also 
worth experimenting with changes to the 
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CLIVE HAYNES FRPS 
Output settings. After returning to the example 
image starting point, we'll look at a further 
step. This is a useful refinement to control both 
a and b Channels in the same dialogue box. 
Begin by activating both Channel a and 
Channel b - do this by clicking on Channel a, 
then shift-clicking on Channel b, as shown 
below. 

Go to Image > Adjustments > Levels. Click on 
the drop-down arrow adjacent to the word 
Channel. This will reveal a choice for the 
independent adjustment of a and/ or b 
Channels, shown here. 

One example of this independent control is 
illustrated in the screen grab below. 

For finer adjustment and extended control of 
tone I suggest that you choose Curves from the 
Image > Adjustments menu. The Adjustments 
menu also presents other options - where the 
humble Brightness and Contrast are worthy of 
exploration. For those who enjoy a not-so
subtle approach, this is a wild example of 
Curves applied to Channel a! 

12 

I could continue to present ever more 
variations to Lab Channel adjustments. 
However it's best if you begin to experiment 
with your own images. 
To complete this section , I include a more fully 
worked example of the image below. From the 
screen-grab you'll notice that the Layer 
structure is more complex. The various Layers 
include tonal variations based upon the 
methods above, Layer Masks and Adjustment 
Layers for both Curves and Hue & Saturation. 

For comparison , the straight Channel-Swap 
image is also shown. 

Working in Monochrome 
For onward conversion and management of an 
image in monochrome, the image can be 
treated in several ways. It 's a matter of 
experiment to discover which one suits any 
given subject the best. The most usual 
methods will be: conversion to mono in the 
RAW file reader; or once opened as a 
Photoshop (.psd) or .TIFF file, the options are: Houseboat 
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Desaturation, monochrome via Channel Mixer, 
Black & White (CS3 on) , Gradient Map, 
Calculations (definitely worth exploring) or 
conversion to Lab mode utilising the L channel 
only. Please note that wherever possible you 
should use an Adjustment Layer as this will 
allow maximum flexibility and editing. 
Converting straight to Grayscale (Image > 
Mode > Grayscale) is not recommended as the 
conversion is frequently bland (although one 
can have the occasional lucky strike) and as 
colour channel information is lost, you 'll need 
to swap back to RGB Mode (Image > Mode > 
RGB) for any toning and tinting, except for 
Duotones for which the mode needs to be 
Grayscale. 
The image below has been opened in CS3 
Bridge and converted using HSL/ Grayscale in 
the RAW Converter and ticking the Convert to 

Grayscale box. In 
,....,,.....,.,,......-------.....,,......,,--, HSL/ Grayscale, it 

can be helpful to 
decrease the 
Oranges slider as 
this will offer some 
increased contrast 
(in this image in the 
sky and water) and 
give a boost prior to 
opening. You may 
notice an increase 
in noise: however, 
magnifying the 
image will show that 
the noise is 
minimal. I've also 
shown the same 
image after 
adjusting Curves to 
provide more 

""""',.......~1 localised contrast 
---=------' and bite. 

Infrared and Water. I recently experimented by 
shooting test images of goldfish in our garden 
pond and I was surprised to discover just how 
far IR could see into the water. The example 
included here isn 't beautiful but it does reveal 
that IR penetrates well below the surface. In 
fact IR allowed me to see further into the water 
with greater clarity than with my eyes alone. 
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I hope that in 
opening the lid of 
this particular box 
of delights you'll be 
keen to make 
adventures further 
into this fascinating 
' Invisible World '. 
Key elements to 
success a re: pre
visualisation of your 
final image, an open 

mind and a willingness to experiment. You 'll 
soon discover which methods enable you to 
express yourself best. Let's see some of your 
results in future issues of DIGIT. 
My website offers information on DI Infrared 
Capture and Workflow plus many other DI 
Know-How Techn iques, and image galleries 
too. Visit: www.crhfoto.co.uk 
And finally, some problems you may encounter. 
Hot-Spots, Occasional Flares and Softness 
In the autumn edition of DIGIT I mentioned 
that, unlike the days of film-based infrared 
photography, DI capture is now far less 
wayward and more predictable. This is certainly 
true, but only up to a point. From time to time 
one can still encounter the odd and 
unexpected quirk from IR capture. This usually 
stems from the fact that we 're asking the 
camera to record a range of tones (light) 
beyond the spectrum that the camera and lens 
combination would have been designed for 
(visible light 400nm - 650nm ). 
A common occurrence is that of a hot-spot, that 
is to say ~ circular light-toned area usually 
noticeable in the centre of the image. In my 
experience it was far more apparent when 
using a non-lR converted digital camera where 
an opaque filter had been fitted to the lens to 
ensure that only IR was transmitted. However, I 
have noticed the occasional barely discernable 
hot-spot using my JR-converted Nikon D7O. 
This is not a fault with the camera or the IR 
conversion or even with the lens (although IR 
may exaggerate a tendency inherent in any 
given lens that is not obvious under normal 
visible light conditions). I found that the hot
spot can occur only under certain exposure 
conditions and that it's largely unpredictable. 
Fortunately the occurrences are rare and can 
be readily dealt with by some deft tonal 
correction work (Leve ls and/ or Curves) in 
Photoshop. 
Hot-spot problems are usually more 
pronounced at apertures from, say, f/ 8 or f/ 11 
and beyond so, unless depth of field is critical , 
a wider aperture will reduce the hot-spot 
considerably. Odd streaks and flares also may 
be experienced from time to time - again a 
vagary of IR capture. The severe hot-spot 
illustrated here occurred 
when shooting with a non-lR 
converted camera , with an 
opaque (I R) filter, stopped 
down to f/ 32. 
Softness is the other 
occasional problem. 
Sometimes, although one is absolutely certain 
that the focus was accurate, the image 
appears soft and the focus a little off. IR 
converted cameras will be carefully adjusted to 
overcome back-focus problems (see autumn 
DIGIT) and should softness occur, the error is 
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CLIVE HAYNES FRPS 
probably the result of the auto-focus 
mechanism simply getting it slightly wrong from 
an infrared point of view. When using a zoom 
lens the error may not be constant or apparent 
at all focal lengths. 
Only by experimentation will this become 
evident. If in doubt, stop-down to a 
considerably smaller aperture to gain greater 
depth of field or use manual focus with a 
guestimate as to the forward or backward 

tweak required. There 's also the consideration 
that not all lenses will transmit IR wavelengths 
the same or as effectively. Even one's most 
favoured and expensive lens may not perform 
as well as expected at the IR end of the 
spectrum. This is hardly surprising considering 
that the manufacturer would have been 
primarily concerned with ensuring the fidelity of 
the optics for visible light. 

Go to: 
www.crhfoto.co.uk 

for more 

Marais Sauvage by Clive Haynes FRPS 

Bert Housley ARPS is also a digital infrared convert. He wrote to say that he had thoroughly enjoyed Clive's article on JR capture 
in the Autumn issue of DIGIT and as a result had even had a Nikon D200 converted by Advanced camera Services. Bert is 
delighted with his results so far, as you can see. To give another user experience Bert will be writing a piece for the spring issue 
of the magazine, with some more of his digital JR images. This one from the Sheffield Botanical Gardens is called Aliens. 
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Notice of AGM and Exhibition Prtnt Selectlon 
with talk by Gavin Hoey on the most useful, exciting and downright fun parts of Photoshop 

The Annual General Meeting of the RPS Dlgltal Imaging Group wlll be held on 
Sunday 19 Aprll 2009 at 1030 

at The Old School House, Smethwick PhotoSoc Club Rooms, 
Ch urchbridge, Oldbury, West Midlands B69 2AS 

Easy access from M5, Junction 2 or t rain. See http://www.theoldschoolhouse.com fo r deta ils. 

1000 Coffee AGM AGENDA 1000 Coffee 
1 Notice of meeting 
2 Formal adoption of the minutes of the previous AGM - see: 
http:f/www.diglt.rps.org/phpBB-3.0.1/phpBB3/viewtopic.php?f=5&t=778 
3 Matters arising from the previous minutes 
4 Annual Reports and accounts: 

• Chairman • Treasurer 
7 Election of Officers and Committee members -

see overleaf for vacancies and Nomination Form. 
8 Any other relevant business 
g Date of next AGM By rail use andweii and Dudley - irmingham 

then short walk, bus or taxi ride. 

The AGM will be followed at about 1100 by the Selection of Prints for the Exhibition 
1300 Lunch, which must be pre-booked, available in the lounge. Licensed bar. Or bring your own lunch 

1400 - 1630 Lecture/Demonstration by Gavin Hoey- Confessions of a Photoshop Anorak. 
A well known writer and demonstrator of digital imaging, Gavin defines Anorak (slang) as a person 
obsessively interested in a thing or topic that doesn't seem to warrant such attention. The talk is the 
distillation of all the knowledge he's gained from spending too much time in front of a computer. In just a 
couple of hours you'll see demonstrations of the most useful, exciting and downright fun parts of Photoshop. 
Gavin will also pass on his thoughts on what to avoid, saving you hours of wasted time learning useless stuff 
you'll never need. Free for Group members - tickets for others £5 on the door. 

~ -
~~ .... ·-·- ·- ·- ·- ·- ·- ·- ·- ·- ·- ·- ·- ·- ·- ·- ·-·- ·-·-·- ·-·- ·- ·-·-·- ·- ·- ·- ·- ·- ·- ·-·- ·- · ..... 

Please cut here to use the booking slip below for lunch or photocopy the booking slip 

~ A two-course lunch is available at £7 per head. Booking and payment must be made no later than 7 April. 

Please book me: D chicken lunches at £7 each 

D vegetarian lunches at £7 each Cheque enclosed for£ D 

Stamped addressed envelope enclosed - please tick: D 
Name: _______________________ _ 
Address: ______________________ _ 

Email address: ________________________ _ 
f,__ _____________________________ .....J 

Please return booking sllp with cheque to RPS DI Group and SAE to: 
Bob Pearson FRPS, Orchard House, Broadhembury, Honlton EX14 3LW 



ANNUAL GENERAL MEETING: COMMITTEE FOR 2009/10 
The AGM provides the opportunity to elect the committee which comprises the four officers laid down in 
the constitution and six further members who may also have specific responsibilities. The President, the 
Secretary and the Treasurer of the RPS are ex officio members of the committee and are 
additional to those elected. DI Group Regional Organisers are also encouraged to make their con
tributions to the committee. 

The positions for which elections will be held, together with the names of the current committee who offer 
themselves to stand for election at the AGM are: 

Officers 
The following offer to stand: 

Chairman: Clive Haynes FRPS 
Deputy Chairman: Chris Haydon 

Secretary General: Bob Pearson FRPS 
Treasurer: Elizabeth Restall LRPS 

DIGROs 

Six Committee Members: 
The following offer to stand: 

Maureen Albright ARPS 
Alex Dufty LRPS 

Anthony Healy ARPS 
John Long ARPS 

Graham Whistler FRPS 
Cesi Jennings LRPS 

Central Southern: Roger Norton LRPS North West: Harry Bosworth South Wales: Maureen Albright ARPS 
East Anglia: Vacant Scotland: Vacant Wessex: Maureen Albright ARPS 

East Midlands: Bob Rowe ARPS Southern: DrBarrySeniorHonFRPS Western: Tony Poole ARPS 
Midlands: Clive Haynes FRPS Yorkshire: Robert Croft LRPS 

Nominations for election to the Committee and for Officers should be put forward in writing by not less than 
two other members of the Group and such nominations must be received by the Secretary not less than 
fourteen days before the date of the AGM. Nominations must be accompanied by the written consent 
of the nominee. In the event of the number of nominations being greater than the number of vacancies, 
election will be at the AGM. 
Note: The editor of the magazine is not a committee post and Jim Buckley LRPS offers to continue in that role. 
Assistance is needed outside the committee to encourage and spot potential articles and images and to help with 
copy preparation. Please see page 5 and contact the editor if you would like to help. 

Please cut here to use the Nomination Form below 
or photocopy the slip for more than one nomination 

~ -- ·-·-·- ·-·- ·- ·- ·- ·-·- ·-·- ·-·-·- ·- ·- ·- ·-·- ·-·-·-·- ·-·- ·- ·- ·-·-·- ·-·-·- ·-·~ 
ROYAL PHOTGRAPHIC SOCIETY DIGITAL IMAGING GROUP 

NOMINATION TO FILL VACANCY ARISING AT THE AGM ON 19 APRIL 2009 
TO BE RETURNED TO THE SECRETARY BY 1700 ON 5 APRIL 2009 

I, ___________________ (Please print) 
wish to stand for election as: or to the Committee. 

Signed Date: _____ 2009 

Proposed by: _________________ (Please print) 
Signed Date: _____ 2009 

Seconded by: _________________ (Please print) 
Signed Date: ____ 2009 

Please return nomination fonn by 1700 on 5 Aprll 2009 to: 
Bob Pearson FRPS, Orchard House, Broadhembury, Honlton EX14 3LW 



DIGITAL IMAGING GROUP 2009 MEMBERS' EXHIBITION 

The 2009 print exhibition will be shown at the following locations: 

Taunton Library, Paul Street, Taunton TA1 3XZ 
Monday 8 June - Saturday 20 June 

The Link Centre, Swindon Library. 
Tuesday 30 June - Friday 31 July 

The Old School House, Oldbury, West Midlands. 
Tuesday 18 August - Saturday 5 September 

Any changes or additions will be displayed on the Website 

Closing date for postal entries - Thursday 9 April 9 2009 
Selection of Exhibition, Sunday 19 April 2009 

You may bring your entry to the Annual General Meeting of the Digital Imaging Group, being held 
at the Old Schoolhouse, Oldbury, West Midlands 

on Sunday 19 April 2009 - if doing so, please send the Entry Form, CD and cheque to Alex Dufty 
- in advance 

Selectors: 
Hilary Roberts FRPS 
Bob Pearson FRPS 

Gavin Hoey 

*** 
Please read the rules carefully 

and complete the Entry Form overleaf 

*** 
Any queries, please contact the Exhibition Secretary 

Alex Dufty LRPS 
127 Bradley Avenue, Winterbourne, Bristol BS36 1HW 

Tel: 01454 778485 
Email: exhibition@digit.rps.org 

For Membership, News, Information, Follo, Forum, Competition and much more 
- Log on to www.dlglt.rps.org 



2009 MEMBERS' EXHIBmON - RULES 

1. A minimum of two prints and a maximum of three prints may be entered. They should be posted 
or delivered to the address on the reverse side of this entry form OR brought on the day if you are attending 
the AGM. In which case. the Entry Form. CD and cheque should be sent to Alex Dufty in advance. 

2. Each print must be marked on the reverse with the entrant's name, address and title as shown on the 
entry form. Mount size must be 40 x 50 cm. 

3. Prints accepted for previous DIG Exhibitions are not eligible for entry. 
4. Packing must be suitable for use in return posting of the prints unless collection arrangements have 

been previously agreed with the Exhibition Secretary. Please remember to include return postage, either 
in stamps, or by cheque. 

5. There is an entry fee of £5 per set of prints. All cheques made payable to: RPS DI GROUP. 
6. A CD must accompany the entry with the images in TIFF and JPEG format if you wish your images to be 

published on the website, on the Exhibition DVD and in the Exhibition edition of DIGIT. Entries for the 
Exhibition without the CD and files in the correct format will be accepted but only shown as Prints. The 
file names on the CD MUST be the same as the print titles to allow us to identify the selected one. TIFFs 
at 300 ppi sized at 15cm longest edge. JPEGs sized 500 pixels longest edge with a maximum file size 
of 95 KB. Mac users please ensure that the image is readable in PC format. 

7. Images to be on CD only, NO FLOPPY DISCS. Names to be written on the CD with CD marker and 
without sticky labels please. 

8. Judging will take place following the AGM on 19 April and will be carried out by the selected judges. Each 
entrant will have one print accepted . A Gold Medal and six Ribbons will be awarded. 

9. Due to constraints on hanging space, it may not be possible to display all the accepted prints at every venue. 
10. The utmost care will be taken of all prints, but the Digital Imaging Group cannot be held responsible 

for any loss or damage during the exhibition or whilst in transit. 

ENTRY FORM - 2009 RPS DI GROUP MEMBERS' EXHIBfflON 
Write carefully please 

Name: _______________ _ RPS Distinction: ____ _ 

Address: RPS Membership Number: ____ _ 

Tel: __________ _ Email: ____________ _ 

Entry fee of £5 enclosed: Please tick D Return postage enclosed: Please tick D 
PRINT TITLES 

1. -----------------------------------

2 __________________________________ _ 

3 __________________________________ _ 

Please return entryfonn by 1700 on 9 Aprll 2009 to: 
A Dufty LRPS, 127 Bradley Avenue, Wlnterboume, Bristol BS36 lHW 



DR DAVID COOKE LRPS 

WEBWISE 3 with David Cooke LRPS 
All the Webwise material is on the DI Group website: http://www.digit.rps.org/phpBB-3.0.1/phpBB3/. You'll need to register 
on the Forum to make comments and to contribute. Click on the Register button on the top right of the main Forum screen. 
There's guidance on how to subscribe to podcasts using iTunes as well as the links given in the previous Webwise articles. 
When you look at them, please do make a comment on the Forum or email me directly at d.f.cooke@open.ac.uk to let me 
know how useful (or not) you found them. And please do recommend sites you've found interesting yourself so other 
members can share them. And I look forward to seeing your images in response to the my Challenge overleaf. 
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Update on The Radiant Vista. player, you can listen to them anywhere. I've 
In the first Webwise (DIGIT no 38, page 35, enjoyed listening to them and I've learned a lot 
Summer 2008), I recommended two features of from them. I highly recommend them to you . 
the Radiant Vista website, namely The Daily Photowalkthrough 
Critique and the Photoshop Workbench. Since http://www.photowalkthrough.com/ 
then , the Radiant Vista has been reorganised Photowalkthrough (subscribe through iTunes) is 
and split into three. The original URL: run by John Arnold, a UK based photographer. 
http://www.radiantvista.com/ is still functional On the site John says that it 'presents video 
but you'll now find links to three new sites. Here tutorials showing the post processing of a 
are two sites of particular interest. photograph using Adobe Photoshop and other 

The Mindful Eye programs. Along the way you will learn about the 
http://www.tmelive.com/ I d h · d · · h · 

is run by Craig Tanner and his associates. It too s an tee n1ques used an gain ins1g t into 
the creative decisions that directed the artist's contains The Daily Critique, many other of the 

features of the old Radiant Vista site, together 
with a number of new ones. To use the site you 'll 
need to register but it's easy, free and I would 
strongly recommended that you do so as I'm 
sure you'll enjoy the things you ' ll find there. If 
you registered on the old Radiant Vista site your 
registration should still be valid on the new one. 

Mark S Johnson Photography 
http://www.msjphotography.com/ 

contains the Photoshop Workbench as well as 
other video tutorials on Photoshop. You don 't 
need to register on this site to view the tutorials. 
If you 'd like to read the original 
recommendations and you don 't have a copy of 
DIGIT, remember you 'll find them on the DIGIT 
Forum. 
I have Recommendations for two podcasts and 
a website this time. 

Thoughts on photography 
http://www.thoughtsonphotography.com/ 

Thoughts on Photography (subscribe through 
iTunes) is somewhat reflective and 
philosophical in nature and Paul Giguere, its 
author, says it covers 'the more fine art aspects 
of engaging with your photography as opposed 
to the gear and technique and that sort of thing. 
It talks more about what you need to do and 
what things you might want to think about as an 
emerging photographer who's looking to get into 
the fine art field.' 
The topics covered are wide and varied, many of 
which are in response to requests from 
listeners. They include, for example, developing 
a photographic style, using projects to sustain 
your photography, book and magazine reviews, 
marketing and selling your fine art photography, 
writing an artist's statement, and interviews 
with photographers 
The podcasts are short, about 10 to 15 minutes 
each and, as they can be played on an mp3 

hand.' 
The podcasts are grouped together into tutorials 
which give very detailed information and 
guidance on the work done on a specific 
photograph. A tutorial typically contains 
between 4 and 8 podcasts (Chapters), each of 
which is typically some 20 to 35 minutes long. 
The website also gives details of what is covered 
in each chapter so it's easy to scan if you are 
looking for a particular technique. 
I particularly like this series of podcasts 
because they go into some depth rather than 
just being quick tips on how to use various 
aspects of Photoshop. 

Masters of Photography 
http://www.masters-of-photography.com/ 

This website contains photographs, as its name 
suggests, by some of the greatest and most 
famous photographers. As well as images, it has 
articles and other resources on each of the 
photographers listed. More photographers are 
being added as the site is being developed. 
This isn 't the easiest site to navigate: when you 
click on a photographer's name you will get 
thumbnails of the photographs which look like 
mounted 35mm slides. Click on the first one. 
This brings up the first image. Then click on the 
magnifying glass icon at the bottom right-hand 
side of the image. This will give you a larger 
image but there will also be an arrow at the 
bottom right-hand side of the image which 
allows you scroll. When you 've finished , you'l l 
find the Home button at the bottom of the 
screen. 
It's a really useful site to get a taste of the work 
of the many people listed. I strongly recommend 
it as a resource particularly for people, like me, 
who are still finding out about the history and 
development of photography and the people 
who have strongly influenced its development. 

RPS DIGIT Magazine Winter 2008 19 



20 

DR DAVID COOKE LRPS 
Since I joined the Digital Imaging Group I've learned a lot from reading DIGIT, 
from the very helpful comments I've had on images I've posted on the Forum 
and from the podcasts and tutorials I've been recommending in Webwise. 
Here are two images which I have produced in that time, together with a short 
explanation of how they were made. If you find them interesting and helpful , 
why not let me have some of your own images, together with a short 
description of how you created them, for publication in DIGIT? We can all learn 
from each other and it would be good to have as many members as possible 
displaying and explaining their work - after all, what greater pleasure can a 
photographer have than knowing that their images are being seen by over 
1000 people? Email me at: d.f.cooke@open.ac.uk 

Light and Shadows. This is an High Dynamic 
Range (HDR) image but in this case made from 
a single RAW image, rather than from three 
separately shot images. The original image was 
first manipulated in Nikon Capture NX to 
straighten and crop it and to selectively bring out 
some of the detail in the shadows. Two further 
images were made from this using raw exposure 
compensation of -2 and +2 and the three 
images (saved as TIFF files) were then combined 
into an HDR image using Photomatix Pro 3.0. 
The result has much more detail and impact but 
there were some over bright areas and 
unnatural colour in some places which were 
adjusted in Capture NX. The image was taken 
into Photoshop for final adjustments: cloning out 
small blemishes and sharpening as shown right. 
If you've not used HDR before you can find 
articles in previous editions of DIGIT (eg Nos 34 
and 38) or type HOR photography into Google. 
Through the passageway. My intention here 
was to produce a sepia image with just a hint of 
colour and the appearance of a line drawing. The 
original Raw image was taken into Capture NX 
where it was cropped and colours and levels 
were adjusted before saving it as a TIFF file. A 
second TIFF sepia version was also made. Both 
images were opened in Photoshop and the sepia 
image was placed in a layer above the colour 
image. The opacity was reduced to 75% to allow 
the amount of colour I wanted in the image to 
come through . The Find Edges filter was then 
applied to a copy of th is layer and the opacity 
was reduced to 36%. Clone layers were used to 
remove the harsh edges around the end of the 
passageway and the post at the bottom right of 
the image; Levels and Curves adjustments were 
applied and finally the ·grain ' was applied using 
a white colour fill layer and adding 
monochromatic Gaussian noise at 250% and 
reducing the opacity of the layer to 31%. 

TAKETHE 
COOKE 

CHALLEN GEi 
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PHIL DRAKE FRPS 

THE LIGHT AT THE END OF THE ROAD: 
IS LIGHTROOM THE ANSWER? 

In the last Issue of 0/Grr Phll Drake told us about his monochrome work. Here he explores the latest 
Adobe offering In the dlgltal world. It may seem llke a tool for the professional or high-end amateur 
who has lots of Images to process but Phll reckons It's a cost-effective piece of software when 
combined with Photoshop Bements to cover all our needs. And even If you don't fancy giving 
Llghtroom a try there's helpful guidance here on Adobe Camera RAW In Photoshop CS. 
On first examination, Lightroom seems very 
similar to Bridge and Adobe Camera Raw (ACR) 
rolled into one. The main difference is that 
Lightroom is a database, while Bridge is a 
browser. Both, however, share the same RAW 
processing engine. I was involved with 
Lightroom from the start, initial ly using the 
Beta version . When the full version was 
launched, I had it on my computer within the 
first week. 
If Lightroom seems to be very much the same 
as Bridge and ACR, why bother to use it? The 
short answer is that I find it very much more 
user friendly. Switching between modules like 
Library and Develop is quick and easy, and 
other features are also very good. 
Don't take my word for it: try it for yourself. I 
think Adobe still offer a 30 day free trial - and 
no, I don 't work for Adobe! 
There are five modules within Lightroom : 
Library, Develop, Slideshow, Print and Web. 
I am going to concentrate solely on Develop. 
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Develop Mode 
The first thing I wish to point out is that tonal 
adjustments are non-destructive in that your 
original images are preserved. This is not just 
limited to RAW files; it also applies to JPEGs, 
TIFF and PSD. To get the full benefit RAW 
should be used since when using pixel-based 
images the results are limited. The 
adjustments are exactly the same as those in 
ACR , so if you are not familiar with them read 
on to discover more about how to use them. 
Let me describe how I adjust the colour and 
tonal scale of my images. I am not saying that 
this the right or only way to work but it works for 
me. It is not something that I developed but it 
is general ly the way most books would say you 
should work. The method is set out for a colour 
image but it is the same for B&W except of 
course you have to convert to B&W - more on 
that later. If you are not familiar with ACR I 
suggest you use an image that is pretty well a 
standard, low contrast image to start with and 
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PHIL DRAKE FRPS 
then try images that have more extreme 
lighting conditions when you get more 
confident. 
Open up your image in Lightroom and select 
Develop on the Top Panel. The panel shown 
here will open up and you will find all the 
adjustment sliders, laid out in a logical way. We 
will work downwards in 
sequence. 
Before we do that it's a 
good idea to crop and 
straighten your image by 
using the tools in the 
Toolbar, found at the 
bottom of your screen 
under the content 
panel. 
Now start on the tonal 
adjustments 
The first box you will see 
is Histogram. If you can't 
see it click on the 
triangle (next to 
Histogram) and it will 
open. This tip applies to 
all the boxes. 
The next box is Basic. 
This is where we will 
change the White 
Balance to adjust the 
overall colour appearance 
of the image. It is a 
matter of persona l 
taste . Click on the 
eyedropper and find a 
spot on your image that 
you think is light grey 
and click in that area. 
If you not happy with the 
result move around your 
image until you find one 
that works better. You 
may find that when 
using the eyedropper it 
automatically docks 
itself after one click. You 
can overcome this by un-ticking Auto Dismiss 
found on the bottom toolbar. 
It also helpful to have Show Loupe ticked, 
found under the image when the eyedropper is 
selected. This gives you a grid showing all the 
colours surrounding the point where you click 
on the image, plus the RGB values (expressed 
as percentages) thereby allowing you to pick a 
better Grey Point. 
Now move down the panel and you will see the 
sliders Temp and Tint. If you need to, fine 
adjust the colour temperature and also the 
colour cast, if one exists. I find I rare ly have to 
do this. 
The next four sliders are used to get the 
maximum detail from your image. You need to 

go back to the 
Histogram and at the 
top corners you will see 
two triangles. These 
show when clipping is 
occurring. The left hand 
one, when clicked, will 
show blue shading in your image denoting 
black clipping and the right hand one will show 
red for highlight clipping as shown at the 
bottom of this column. 
If you don't see this then great, you have a 
perfectly exposed image with no loss of detail. 
If you wish you can leave these triangles 
switched off and just watch the triangles when 
moving the sliders. They will change to the 
colour of the channel that is being clipped . 
Grey donates all channels are clipped , as 
shown alongside. 
I know you purists are going to raise your 
eyebrows, but before any adjustments try 
clicking the Auto button. The results are 
surprisingly good! 
Start with Exposure. With this adjustment you 
need to have the four sliders - exposure, 
recovery, fill light and blacks - set to the default 
setting of zero. If using RAW the Black default 
setting is 5. Leave it at that. 
Move the Exposure slider until you just get 
Highlight Clipping (Right Triangle or Red 
Shading will come on as already described) 
and then back it off until it just disappears. 
Using the Recovery slider will enable further 
recovery of highlights but we will come to that 
in a moment. 
Jump the next two sliders to Blacks. This time 
you are adjusting Shadow Clipping and you will 
be looking at the left triangle. Move the slider 
until shadow clipping occurs and then back it off 
until the lit triangle goes off. Try not to have the 
Black slider at zero. To avoid this you may have 
to adjust the Fill Slider. 
You will next have to adjust the two sliders which 
up to now we have ignored - Recovery and Fill 
Light. Start with the Fill Light. This adjusts the 
detail in the shadows. You will probably find that 
you will have to juggle with this and the black 
slider to avoid shadow clipping. The recovery 

RPS DIGIT Magazine Winter 2008 



slider puts back any lost detail in the highlights. 
In theory you shouldn't have to use either but 
bel ieve me you wi ll. Much of what you do will 
depend on how good your initial exposure was 
and the tonal range of the subject. If very over or 
under exposed a compromise may have to be 
made. It will be up to you to decide whether to 
lose shadow or highlight detail. 
The next two sliders are Brightness and Contrast, 
which I use sparingly. I tend to use the Tone 
Curve, detailed below, or when the image is in 
Photoshop I use Curves to get the image exactly 
how I want it. 
The Clarity slider is used, as Adobe describes it, 
to add depth to the image by increasing local 
contrast. What this does is to make the image 
more punchy: the same thing can be done in 
Photoshop using Unsharp Mask and playing 
around with it but here it is so easy with just one 
slider. How much to adjust is down to persona l 
preference. Just don 't over do it! 
Vibrance & Saturation seem to be the same thing 
but they are not. Saturation adjusts all the 
colours by the same amount whereas Vibrance 
increases the lower saturated colours more than 
the higher ones. Adjusting these is a matter of 
persona l preference. 
The next step is the Tone Curve Box. This is a very 
easy to use curves tool. You have the choice of 
applying three different types of adjustments, 
Linear, Medium Contrast or Strong Contrast by 
selecting one from the Point Curve. 
Then, by using the sliders or by dragging the 
curve, you can selectively adjust Highlights, 
Lights, Darks and Shadows. Another feature is 
the Target Adjustment Tool (located in the top left 
of the box). By clicking on this and then dragging 
up or down in the image itself you can alter the 
tones of the image. 
This is the point where I normally exit Lightroom 
and go into Photoshop. To do this simply hit Ctrl + 
E and a dia log box appears asking what File 
Format you require, the Colour Space and Bit 
Depth. Click OK and you will open up Photoshop 
CS or Elements depending on what you have 
installed. If you have both then it will open in 
Photoshop CS unless you have the defau lt set 
otherwise. 
Once in Photoshop I work on the image in the way 
most people do - Selections, Layers, Curves, 
Levels and Layer Masks to get the finished 
picture exactly the way I want it. Finally remember 
it's your photograph so don 't get too hung up 
about the technical aspects. Produce the image, 
as you want it. 
As previously said, the adjustments carried out in 
Lightroom were for a reasonably exposed image. 
If you had extreme over or under exposure or an 
extreme highlight to shadow ratio then you will 
have shadows or high light clipping or both. 
B&W 
I am told that there are around eighty plus ways 
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Triangle Lit 
Denotes Shadow 
Clipping. 

'Iriangle n1it 
Denotes No 
Highlight 
Chpping 

PHIL DRAKE FRPS 

to convert to B&W in Photoshop. Well here are a 
few more! 
To convert an image to B&W in Lightroom you 
have a number of options. Select one of the B&W 
Presets, click on Grayscale in the Basic Panel or 
desaturate by using the Saturation Slider. The 
term Graysca le in Lightroom is a bit misleading. 
It 's not the same as Grayscale Mode in 
Photoshop: it is in fact an RGB image. 
Other Features 
Some of the other features within the Develop 
module are Crop, Red Eye Removal , Clone and 
the ability to see the image before and after 
adjustments. 
Conclusion 
Now updated to Lightroom 2 this is a great piece 
of software; it's easy to use and quick. To get 
maximum benefit from it RAW files should be 
used. At around £200, it's good value for money. 
Combine this with Elements, often given away 
free, and you have a couple of powerful programs 
at less than half the price of CS3 or CS4. 
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CLIVE HAYNES FRPS 

MAKING CURVES WORK FOR YOU 
Do these statements seem famlllar? What are Curves? Why do we need Curves? I 've looked at 
Curves and they're complicated/ Regrettably these responses do rather typify many a first contact 
with Curves. Some people venture once, never returning to discover what Curves can offer; others 
use only part of the great potential of Curves. Here DI Group Chairman Cllve Haynes gives you all the 
spin on Photoshop's Curves. 

A
s a teacher of photography and Photoshop 
for many years I always sought to 
demystify Curves and to promote its use 

as of one of the most powerful tools in 
Photoshop. Indeed my website has numerous 
pages devoted to understand ing Curves. Many 
pages, yes, but not because Curves are that 
complicated. It's just that I've divided know-how 
about Curves into easily digestible portions. In 
this issue of DIGIT I should like to illustrate one 
frequently overlooked aspect of using Curves -
the advantage of working with Luminosity Blend 
Mode. (The same practice can also be used with 
Levels.) 
Working with Curves in Luminosity Blend Mode 
Most people tend to make tonal adjustments in 
Curves that affect both colour and luminosity 
content simultaneously. 
When adjusting and modifying the shape of the 
curve in Normal Blend (the default mode) we 
affect the composite RGB content of the image. 
For small changes the alterations to colour, 
although present, are not usually significant. 
However when making more dramatic changes 
to the tonality of an image by lightening, 
darkening or increasing the contrast range, 
changes to the colour content become more 
pronounced and frequently undesirable. 
It's often better practice to apply tonal changes 
to the underlying black and white (Luminosity) 
content of the image when we need to alter 
contrast. And to achieve this it's preferable to 
use an Adjustment Layer. 
The Adjustment Layer route is the preferred 
option as not only is it non-destructive but also 
it has a useful Layer Mask, which is invaluable 
for the selective application of the adjustment 
needed. This mask appears as a wh ite box to 
the right of the Curves adjustment icon as 
shown to the right here. 
Creating a Curves Adjustment Layer 
At the base of the Layers palette, click on the 
half black/ half white circle icon. From the drop
down list that appears, choose Curves. 
To illustrate the value of working with 
Luminosity Blend Mode we 'll first look at the 
example image oppos ite, with the Curve 
adjusted using Normal Blend mode. Notice that 
the contrast has increased and colour va lues 
become more intense - in this instance this is 
undesirable. 
The next example shows the effect of choosing 
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Right: 
Luminosity Blend Mode 

Below: 
Activating the Curves 
Adjustment Layer 

Bl'end Mode 

The starting image Normal Blend Mode 

Luminosity Blend Mode with the identical 
adjustment to the shape of the Curve. To 
change the Blend Mode, click on the drop-down 
arrow to the right of the Normal box (at the top 
left hand of the Layers Palette) and from the 
drop-down (Blend) menu, choose Luminosity. 

The alteration to the 
contrast has become 
more subtle as it now 
emphasises the 
change of underlying 
tone rather than 
co lour. 
In this example the 
Curves adjustment 
has been initially 
applied to the whole 
area of the image. 
However, in the 
images on the facing 

___ ...., page I have used the 

- X 

v Opacity : I 100% > I 
Fill : j 100% ,> I 

• __J 1l ... 
.... 

Adjustment Layer Icon 
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Paintbrush tool and, with black, as the 
foreground colour, areas of the change have 
been selectively removed . 
When painting on the Layer Mask associated 
with the Adjustment Layer white will apply the 
change and black will undo it. You can see what 
you 've done by looking at the box to the right of 
the Curves adjustment; you will see where 
you've applied black to suppress the effect of 
the Curves adjustment. Judiciously swapping 
between the black and white (press X on the 
keyboard in Windows) will produce a pleasing result. 

- X 

j~L=a~y=er~s~x--=:..:t= ;"'lr--;:::=::::;---- T= 
Normal 

Normal 

Dissolve 

Darken 

Multiply 

Color Burn 

Linear Burn 

Darker Color 

Lighten 

Screen 

Color Dodge 

Linear Dodge (Add) ' 

Lighter Color 

Overlay 

Soll Light 

Hard Light 

Vivid Light 

Linear Light 

Pin Light 

Hard Mix 

Changing the 
Blend Mode: 
Click on the 

Drop-Down Arrow 

Difference 

Exclusion 

Hue 

Saturation 

Color 

Below: The Curves adjustment is a gentle S-shape 

Curves .... ~ 

pteset: § tom "'· ~ 
Channel: j,-RG- 8---~ ------- ~ 

'-· -~--------=----=---=------~ la./ 

• 6 
[nput: 

~ JI / / 0 Show_Clq:,i,o 

~ Ccr,e Display Options 

Srow Amount of: 0 Llght (0-255) 

O Pi\lm8nt/lnl<% 

Show: 0 Chama! Oyerlays 0 !laseline 

0 1::!istogram 0 1atersecton l.ha ----~-' 
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Want to kick start your 
Curves? 
Go to: 
http://www.crhfoto.co.uk 
/ crh/ curvesp03.htm 

Left: 
Changing the Blend 
Mode to Luminosity 

Below: 
Selective masking of the 
Curves Adjustment layer 
produces this final result 

By clicking on the Curves icon 
on the Adjustment Layer, the 
Curves dialogue box will re
open and further tweaks and 
changes can be made - to be 
able to re-visit is one of the 
advantages of using an Adjustment Layer. 
The decision whether or not to apply Curves in 
Luminosity Mode will depend upon the image 
and the outcome that you pre-visualise. For 
some images the boost given to the colour 
content is appropriate whilst for others an 
increase in underlying contrast is all that is 
required . Experiment as to which answers your 
needs best by swapping between Normal and 
Luminosity. 
And , as mentioned above, working in Luminosity 
Mode is equally applicable for the adjustment of 
Levels too. 
For more information about Curves, including 
using Curves in Luminosity Blend Mode, please 
visit the Know-How section of my website: 
www.crhfoto.co.uk 
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Left: Puffin 
Right: Birth of a Dragon 

Right: Looking for Tom 
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ESSENTIAL 
TECHNIQUES? 

Gwynn Robinson asks of these two 
contrasting Images: How do I produce 
Images llke this? What essentlal 
techniques did I need to master? 
Is It dlfflcult? Do I possess some speclal 
ablllty? What makes It posslble? 
And offers his personal approach to the 
technique-free skllls you should acquire. -----------~ 

The first technique I use is applicable to both 
traditional photography and to the creative work 
that I do - visioning or seeing: roughly (at least) 
knowing what I want to capture. For landscapes 
this translates to capturing (and expressing) the 
experience. For creative work, this means 
expressing the concept. For portraiture we need 
to show the context and embedded history of 
the person. Sport? The ach ievement, anguish, 
effort and so on . 
Photography is all about thought. Thought 
before the image is captured and thought by the 
observer of the image later on. The connection 
or communication is what we are after. 
Whether I go out to shoot a landscape, set up a 
portrait or create a fantasy it is important to see 
the image that I am trying to produce. It can 
take some t ime at a location or with a set up to 
feel the scene and to see the image that I 
wanted. Sometimes I have to take a few images 
before I settle down and understand more ful ly 
what I am trying or able to do. 
Sometimes I go out and just take pictures to 
enjoy taking pictures, but it is rare that I get any 
useful material when I do. It doesn 't matter as 
long as I enjoy myself and don 't mind not ending 
up with great images. But when I concentrate, 
start to really look and care about the image I 
am trying to capture, I enter a different world 
and it becomes possible to get the very best out 
of the situation. 
It takes time to learn to see too. I now look much 
more carefully and check out different angles, 
zooms and depths of field. But at the start of my 
photographic journey I just shot what I saw and 
liked. What made the difference for me was 
being with other people who saw things and 
captured th ings differently. Their images were 
often much better than my own - certainly they 
were different. I learned by seeing other 
people's work in the same situation. I learned by 
seeing my own images and understanding the 
shortcomings. Club outings can be excel lent for 
learn ing (and enjoying) - as long as the best 

(and worst) images are then seen by the club 
members - perhaps in a competition - so all 
can learn. 
Once you start to 'see ' then images appear 
everywhere, wherever you are. 
Recently I was out on the beach with a friend 
walking. We came across a rather rough 
'sculpture ' made out of rubbish. I was intrigued. 
We had both of us brought our new compact 
cameras to try them out. We were both of us 
interested in the object. I took about 50 pictures 
of it from all angles, zooms and positions. My 
friend took just one image thinking that that 
would be enough. He learned very little. I 
learned more. I enjoyed it more. I was immersed 
in it and experienced more about the sculpture 
and its textures/ colour/ form as I worked with it. 
I got to wondering about who had crafted the 
wood. What did they do? Why had the created 
this? Who did they show it to? I got a 
competition image from it but I got a whole lot 
more from the experience as a whole as I 
immersed myself into it. I enjoyed being with the 
sculpture and spending the time capturing the 
image. My friend was quickly bored with it all 
and just wanted to go home. 

But what of the more fantastic, creative work 
that I do? Well the first thing that I must say is 
that it is not for everyone. 
It requires a lot of imagination, cheek, a sense 
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of fun, a deep desire to say something, a whole 
stack of different techniques and lots of time on 
the computer. 
Traditional photography requires a few post 
processing techniques adjustments 
(brightness, contrast, saturation, sharpening). 
Brightness, contrast and saturation are 
relatively easy to adjust as you can see the 
immediate result. Sharpening is more difficult 
and many people seem to over do it. I use a set 
of standard low sharpening settings that work 
for all images. 
Creative work requires considerably more 
techniques (selection, copy, paste, cloning, 
recolouring, resizing) - nothing particularly 
complex there. However, Creative work also 
makes use of filters, effects, and distortions. It 
can be quite offensive to some traditionalists 
and so may not suit. But if it does then basically 
anything goes. 
Here is a creative image that I have always liked. 
It formed part of my FRPS. I am sure I could 
improve on it but that is the problem that we all 
face. Whatever image we create or capture, 
most of us will look at it and know that it could 
be improved. Do we go out and reshoot or 
recreate? I sometimes do. The models here are 
a set of three bronze figurines. I have a whole 
series of different images with them in exactly 
the same position - just different uses of filters 
and effects. 

Trad itional photography requires effort. You 
have to go to the location, look around, spend 
time there, wait for the right light, take many 
images from different perspectives. Take in the 
location so that you can communicate your 
experience in your images. It takes time and 
effort. 
What I am saying is that whatever your style of 
photography, capturing good images requires 
considerable time and effort - like any 
worthwhile journey. The very best images 
require dedication and determination too. It is 
unusual to find someone who will naturally 
learn and create the very best in photography in 
total isolation - so put in that effort but do it as 
part of a group. For me the group activity 
enhances my enjoyment more than anything 
else. I learn new techniques from those around 
me. I can also learn which techniques don 't 
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Left: Dance of Life 
(FRPS Image) 
and Alive!!! 

Below: Piece by Piece 
from Gwynn's A Panel 

seem to work or will not 
suit my style of 
photography an 
equally important 
aspect. And I enjoy the 
company. 
My personal favourite style? I must admit that I 
do like the more fantastic creative work. It is 
different. It makes people sit up and take 
notice. It is a good medium for communicating 
ideas, thoughts, statements, concepts. 
Does the style of photography matter? I have 
heard all sorts of discussions and arguments, 
some pretty heated, especially over traditional 
versus creative. Thankfully the arguments are 
abating - there's little point in them anyway. It is 
impossible to stop 'change'. Our art will always 
change. Art always does as we, as artists, grow 
and learn. 
My recent FRPS was based upon conceptual 
creative work hopefully demonstrating to 
everyone that high acclaim can be achieved in 
non traditional ways. 
Don 't be discouraged if your present work 
doesn 't seem to match up to the best around 
you. Photography is a journey. A journey to be 
enjoyed and to be taken at your pace not the 
pace of others. But it is a good journey to take 
with friends, to compare notes and to help each 
other. 
My view? The most essential technique is being 
with like minded people in a group and learning 
from each other on outings and in the society 
meetings, so I urge all clubs and societies to 
include your members into active participation 
- outings - learning sessions - practical 
aspects. After all photography is a practical 
activity. To me this is the essential photographic 
technique to ensure that our photographers do 
well and enjoy their life long journey of 
photography. 
I run an online photographic society to help 
people grasp the new technologies and enjoy 
their hobby, and attain RPS distinctions. Take a 
look at WIGIT at: www.good-image.co.uk 
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JIM BUCKlEYLRPS 

START HERE -AND KEEP IT SIMPLE! 
Jim Buckley, Editor of DIGIT, offers his slmple start rtght solutlon to those taking their first tentative 
steps with a new dlgltal camera and a PC. Next time Mac expert Tony Healy ARPS wlll give his 
approach to getting started on the Mac, with Its own bullt In software especlally for dlgltal Images. 

When you've mastered 
the basics and want to 
have fun, try Actions in 
Photoshop. To make It 
easy on yourself take a 
look at www.panosfx.com 
for some really useful 
little routines. Some 
are free, others cost 
relatively modest 
amounts for a great 
deal of fun. 

Make yourself a film 
strip, book cover or 
even a jigsaw. These 
are just a few of the fun 
ways to use Panosfx 
Actions in Photoshop 
and they take only a 
short time to run. 
Downloading is easy 
with clear Instructions 
on the website. 

A
h, they say: You know about cameras. 
What digital camera shall I buy for 
myself/ my son/ my grandmother? My 

response is always the same: Why buy a digital 
camera? What's wrong with your film camera? 
Somewhat crestfallen they ask: So you still use 
film, do you? Well, err, actually No. From that 
moment I know the battle is lost as they explain 
to me that digital is great for photographing 
children, you can delete the ones you don 't 
want, you can email your snaps to the relatives 
on the other side of the world, and these new 
cameras even take videos. Wonderful!. 
OK, so they are hooked. How best to guide them 
without making it all too complicated? Do you 
even need a computer? If you haven't got one 
you can take the memory card to a high street 
processor and have prints made on the spot. If 
you do have a PC you need to be clear that you 
are familiar with Windows Explorer so you can 
store, move and - importantly - find files again. 
Above all you need to be organised. If you're not 
confident with your PC get a friend to guide you 
through these simple steps. So here we go: Top 
Tips for the first few months with your new 
compact or D-SLR. 

• Set it to AUTO, select Red Eye Reduction 
and leave it at that till you gain confidence. 
Modern cameras are incredibly sophisticated 
with myriad functions. Don 't fidd le or you 'll end 
up filling your memory with video when you 
wanted a quick shot of the children. 
• Make a new folder - not on your desktop (nor 
in My Pictures as Microsoft would have you do 
it) but on your main drive, C. Give the folder a 
date and title - 2009 Photos. Now create sub 
folders for each occasion such as New Year 
Party, Johnny's Christening, Paris. 
• Ignore the manufacturers' software: it will 
take over your computer. Use the cable supplied 
to connect your camera to a USB port on your 
PC. Switch on the camera, open Windows 
Explorer and there you will 

Double click to access the images on the 
memory card and they will appear on the 
screen. 
• Highlight the ones you want to save. Either 
Drag and Drop to the appropriate folder or right 
click, Copy and after navigating to your chosen 
folder, right click again for Copy. 
• OK, so now you're sure they are on your PC 
you can safely reformat your memory card in the 
camera so you 're ready to go again . Ideally, if 
these are unrepeatable shots, back up to a disk 
or external hard drive. 
• Since you ignored the manufacturers' 
software and it's too early to spend your cash on 
PaintShopPro or Photshop Elements, download 
the FREE Picasa from Google at: 
http://picasa.google.com/. Remarkably 
intuitive and with lots of online help and 
tutorials, Picasa 3 wi ll meet your needs for the 
first few months at least. You wil l be able to 
crop, straighten, enhance, print and email your 
photos from your new toy with ease. 
• Remember the Five Fs of Fotography which 
are just as valid in digital: 
* Fill the frame, don 't waste pixels 
* Frame the subject to concentrate attention 

and avoid distracting backgrounds 
* Focus carefully. Select your subject, half 

depress the shutter, then re-frame as necessary. 
* Flash, built in or pop up, can be used 

creatively against the main light to put sparkle 
in eyes and lift the shadows. Select Flash on. 
* A Firm hold on the camera, squeezing the 

shutter rather than jabbing, will ensure sharp 
shots. 
• And finally, print out your pictures for the 
album or make a photobook using one of the 
online services like www.photobox.co.uk. 
Photographs are meant to be seen. 
When all this is second nature we 'll introduce 
you to Levels, Layers, Sharpening, Curves and 
all the wonders you can read about in DIGIT. 
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HILARY ROBERTS FRPS 

BARRIE AMONGST US 
In February 2008 HIiary and Peter Roberts travelled to Cuba for a unique celebratlon of the wort< of 
Barrie Thomas FRPS. And over the page HIiary tells us something of her photographic love affair with 
this central American Island. 

R
emedios is on the north coast of Cuba, 
some six miles from the sea and was 
founded by the Spanish in the 1520s. 

Today it is a sleepy backwater which few tourists 
visit. There is a beautiful church, one ten-roomed 
hotel and a pretty square. Much of the housing 
is in very poor condition, there is no transport in 
or out and the few shops stock only basic 
commodities. The richness of Remedios lies in 
its people, who like most Cubans are delightful -
friendly, welcoming and kind. 

Right: 
The Square, Remedios 

Left The poster 

We went to Remedios last February because of 
Barrie Thomas, our dear friend and well-known 
Photoshop guru , who is remembered with 
affection and gratitude by some citizens of 
Remedios. Barrie visited Remedios severa l 
times with us, and during a visit there with him 
and his wife Pam a few years ago we met by 
chance in the street a professional photographer 
called Loly, and her .----- Waiting 
husband Obel. They were 
struggling, because their 
on ly camera had gone 
wrong. A well-meaning 
tourist had taken it to 
Belgium, allegedly to be 
repaired, but we all knew 
that they were un li kely to 
see it aga in, not least 
because it wou ld never 
get back via the Cuban 
postal system. I had a 
back-up camera , and I 
gave it to Loly and Obel, 
enabling them to start 
work aga in. Barrie had 
his laptop with him, and 
the sight of him giving 
lessons in Photoshop to 
Obel is one I shall not 
forget - Obel speaks no 
English and Barrie 's 
Span ish was limited to 
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·caramba' which he remembered from Western 
films. On his return home Barrie sent me a copy, 
in Spanish , of his magnificent book "A 
Photographer's Guide to Photoshop" and on my 
next visit to Cuba I took it with me and gave it to 
Obel and Loly. 
Everyone in Cuba who had met Barrie was 
devastated to hear of his untimely death, 
especially his friends in Remedios. Loly and Obel 
decided that they would like to hold an exhibition 
of photography in Barrie 's memory. They 
negotiated with the regiona l arts organisation 
and overcame the stultifying Cuban bureaucracy 
to secure the local gallery, a decrepit colonial 
building, for the exhibition. During a visit in 2007 
with Pam Thomas and a photographer friend 
from Austra lia, Trish Taylor, we gave Loly and 
Obel prints from all of us for the exhibition. 
Subsequently we printed some of Barrie 's F 
panel here in England and took them to 
Remedios just in time to be mounted and 
framed for the exhibition. >>> 
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HILARY ROBERTS FRPS 

Loly and Obel worked themselves practically to 
death preparing everything for the exhibition . 
Together with the staff of the gallery they framed 
all the pictures and organised the opening night. 
They produced posters and secured publicity on 
the radio and television . They arranged to have 
a book for people to sign when they came, and a 
little podium on which was a photo of Barrie, and 
a biography in Spanish and English which Pam 
had asked me to write. A well known Cuban poet 
who lives in Remedios composed a poem about 
Barrie and this was printed and enclosed with 
each copy of the exhibition leaflet. And all this in 
a country where you cannot pop out and buy 
mount board - or anything else - and to go to 
the printers you have to stand by the side of the 
road and hope to hitch a lift in an open lorry. 
The exhibition was called Barrie Amongst Us. On 
the opening night Peter and I were quite 
overwhelmed. Two hundred and twenty people 
came, and filled the gallery to bursting. There 
were speeches and a short concert by two young 
musicians. Beautiful bouquets were presented 
and sparkling wine was offered. There is a huge 
appreciation of the arts in Cuba and all the 
photographs framed on the walls were 
scrutinised and enjoyed by everyone. A sweating 
cameraman from the local TV station followed 
every move and interviews were carried out. The 
exhibition was open for a month, and in the days 
following the opening everyone else in Remedios 
who hadn 't come on the first night stopped by to 
admire the display. 
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Above: Girl with Barrie's 
portrait of her from a 
few years before. 

Ready for the opening 

When we left Remedios a few days later we were 
presented with a video recording on DVD of the 
opening evening, so we are able to relive the 
experience whenever we wish. Taking part in the 
exhibition was very moving for us, partly because 
of the huge effort everyone had made in very 
difficult circumstances to make it happen, and 
partly because it felt almost like a memorial 
service for Barrie and helped us finally to say 
goodbye. We hope that Digital Imaging Group 
members, many of whom also knew and loved 
Barrie, will enjoy this opportunity to hear our 
account of the event and see some images 
which nevertheless give a flavour of this 
extraordinary happening. 
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Above: Old Boys' Club by Hilary Roberts FRPS 
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Below: Two Bald Men with Shades from Barrie Thomas' 
digital Fellowship Panel. 
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HILARY ROBERTS FRPS 

TEN REASONS WHY I GO BACK TO 
CUBA WITH MY CAMERA 

1Every face in Cuba is different. If you go to Sri 
Lanka , Thailand , India, you get lots of 

wonderful photos of people but they all have 
pretty much the same skin colour and features. In 
Cuba they vary from black to white, and 
everyth ing in between. And without exception , 
they are beautiful. You even find black people 
with blue eyes. Your pictures are not necessarily 
unmistakably Cuban. The on ly way judges can 
definitely identify an image as Cuban is if you 
have included the Cuban flag, Che, Fidel or a 
cigar. 

2 It is quite difficult to put on weight in Cuba. 
Because of the American embargo, and the 

total inefficiency of all systems in Cuba, there is 
not much to eat. At least ha lf a stone weight loss 
was guaranteed when Peter and I first used to go, 
because we lived on bananas. Unfortunately, we 
eat well now, because we stay with people we 
know, so it is not so good for getting thin. 

3There are lots of dogs in Cuba. Dogs enhance 
pretty well any picture, providing points of 

interest, filling up empty spaces etc. Dogs have 
featured in all my successful images over the 
past few years. Dogs in Cuba are full of character, 
even when sleeping, and are just as photogenic 
and keen to be included in pictures as the 
people. Anyway, I like dogs. 

4There are wonderful backgrounds to be found 
in Cuba. This is mainly because they cannot 

afford to renovate the beautiful , old, colonia l 
buildings. Thus there is a lot of decay - always a 
winner in photos. Fortunately for the Cubans, who 
have to live in these houses, money is gradually 
being spent on them. So soon everywhere will be 
done up, and Havana will be like many European 

cities - smart and boring. 

5Cubans, apart from being very photogenic, 
are delightful people. They are friendly and 

welcoming - and they love to be photographed. 
Despite the awful problems besetting them they 
have a wonderful sense of humour. 

61 make a point of walking around the grottiest 
part of any town, and I have never felt 

threatened . This doesn 't mean you don 't take 
sensible precautions, the most important of 
which is to be friendly and talk with people - and 
ask if it is OK to photograph them. 

7 Life in Cuba goes on in the street, because it 
is generally hot. This means that photos of 

people playing dominoes, having their hair cut, 
selling pies or being shaved are very easy to get. 
In any case, there is usually no glass in the 
windows, and people don 't mind you peering in , 
and will readily invite you in if you show any 
interest, and encourage you to take photos inside 
their houses. 

8There is no malaria in Cuba. So you don 't 
have to take those awful tasting pills. 

gMotorway driving is much less stressful in 
Cuba than in England. All you have to worry 

about are the potholes, the complete lack of 
signs, the people on bicycles and horses coming 
towards you in your lane, the fact that there have 
been no parts available to maintain your car 
since 1952 and the men who suddenly leap out 
in front of you waving strings of onions or home
made cheeses. In any event, motorway driving is 
much safer than internal flights in old, single
engined Russian planes for which there are also 
no parts. 

And finally, I am not tempted to revert to being 
a wildlife photographer in Cuba because most 

of the wildlife has been eaten. 
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